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Abstract- PET is used effectively for biochemical 
or pathological phenomena, disease diagnosis, 
prognosis determination after treatment, and 
treatment planning because it can quantify 
physiological indicators in the human body by 
imaging the distribution of various biochemical 
substances. However, since respiratory motion 
artifacts may occur due to the movement of the 
diaphragm due to breathing, we would like to 
evaluate the practical effect by using the a device-
less data-driven gated technique called Motion Free 
(DDG) with the phase-based gating correction 
method called Q.static scan mode. In this study, 
images of changes in moving distance (0 cm, 1 cm, 2 
cm, 3 cm) and degree of slope (0°, 2.5°, 5°, 10°) 
were acquired using a breathing-simulated moving 
phantom. The diameters of the six spheres in the 
phantom are 10 mm, 13 mm, 17 mm, 22 mm, 28 mm, 
and 37 mm, respectively. According to SUVmax and 
SUVmean measurements, when DDG was applied 
based on the moving distance, 

 
 

Jinyoung Kim  

Dept. of Nuclear Medicine, Chungbuk University Hospital  

e-mail : korotkoff@khidi.or.kr 

 
Geahwan Jin( )   corresponding author 

Dept. of Radiology, Nambu University 

e-mail : ghjin@nambu.ac.kr 
 

the average SUVmax of the correction effect by the 
moving distance was improved by 1.92, 2.48, 3.23 
and 3.00, respectively, and the average SUVmean 
was improved by 0.04, 0.72, 1.36 and 1.49, 
respectively.  

When DDG was applied based on the diameter of 
the phantom spheres, the average SUVmax of the 
correction effect by the moving distance was 
improved by 2.37, 2.02, 1.44, 1.20, 0.42 and 0.52, 
and the average SUVmean was improved by 1.36, 
1.23, 0.99, 0.82, 0.57 and 0.43, respectively. The 
correction effect by the degree of slope also 
improved the average SUVmax when DDG was 
applied to 2.93, 2.87, 1.61 and 1.45 respectively, and 
the average SUVmean to 1.61, 1.27, 0.8 and 0.95 
respectively, based on the degree of slope. when 
DDG was applied based on the diameter of the 
phantom sphere, the average SUVmax was improved 
by 0.77, 1.73, 1.84, 2.56, 3.46 and 2.93 respectively 
and the average SUVmean was improved by 0.56, 
0.44, 1.19, 0.98, 1.66 and 2.13, respectively. In the 
visual comparison due to the change of the moving 
distance and the degree of slope, it was found that the 
more the moving distance increases, the greater the 
degree of slope increases, the greater the correction 
effect of DDG. In the case of the area ratio, Based on 
the image with a moving distance of 0 cm, when 
moving distance was 1 cm, 2 cm and 3 cm, the 
difference between applying and not applying DDG 
was 5%, 12%, and 18%, respectively. Based on an 
image with degree of slope of 0°, when degree of 
slope was 2.5°, 5° and 10°, the difference between 
applying and not applying DDG was 6%, 7%, and 
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7%, respectively. In the case of the average density 
ratio, Based on an image with a moving distance of 0 
cm, when moving distance was 1 cm, 2 cm and 3 cm, 
the difference between applying and not applying 
DDG was 3%, 6%, and 8%, respectively. Based on 
an image with degree of slope of 0°, when degree of 
slope was 2.5°, 5° and 10°, the difference between 
applying and not applying DDG was 3%, 4%, and 
5%, respectively. In the comparison of FWM, 
FWHM, and FWTM, Based on the image with a 
moving distance of 0 cm, when moving distance was 
1 cm, 2 cm and 3 cm, the difference between 
applying and not applying DDG was 1.6%, 9% and 
9.4% in FWM, 4.4%, 7.6% and 6.4% in FWHM, 
12.1%, 23.4% and 30.5% in FWTM respectively. 
Based on an image with degree of slope of 0°, when 
degree of slope was 2.5°, 5° and 10°, the difference 
between applying and not applying DDG was 3.0%, 
3.2% and 11.7% in FWM, 2.7%, 5.0% and 2.3% in 
FWHM, 12.2%, 6.3%, and 7.5% in FWTM 
respectively. It means there is a quantitative 
correction effect when applying DDG. This shows 
that the overall experiment has a correction effect 
when applying DDG. 

 Key word: PET, Breathing Synchronization System, 

Motion Artifact, Correction Effect 

 

I. Introduction 

Positron emission tomography (PET) can 

quantitatively measure physiological indicators 

of the human body by imaging the distribution 

of biochemical substances in the body. For this 

reason, it is useful for identifying biochemical 

or pathological phenomena, diagnosing diseases, 

determining prognosis after treatment, and 

planning treatment. Although very useful, PET 

has the disadvantages of relatively low image 

resolution and difficulty in assessing anatomical 

location and relationship to surrounding tissue.  

To compensate for these disadvantages, a 

fusion type PET/CT combining PET and CT has 

been developed and is currently being actively 

used[1]. Standardized Uptake Value (SUV) is 

evaluated to assess disease status and tumor 

uptake and treatment response using 18F-

fluorodeoxyglucose (FDG), a glucose derivative, 

through abnormal uptake by cancer cells. SUV 

is influenced by patient body shape, blood 

glucose concentration, tumor size, increased 

normal tissue uptake, radiopharmaceutical dose 

and examination time interval, and region of 

interest (ROI). This phenomenon is used to 

semi-quantitatively measure the radioactive 

concentration accumulated in tissues and is 

currently widely applied in clinical practice [2-3]. 

SUV may not be accurately measured due to 

movement of the diaphragm due to breathing 

during the examination, and errors may occur in 

the fusion image of PET and CT, which may 

cause SUV reading errors and accurate 

measurement.  

With the development of inspection equipment, 

it has changed to a semiconductor-based 

collection method, and even in the method of 

correcting breathing, it is motion-free (data-

based gate without a device, DDG), rather than a 

method of attaching or attaching an external 

device separately. It is installed as software on 

the equipment and can be applied practically in 

the clinical field. DDG is an algorithm that 

analyzes principal component analysis (PCA)-

based data without external equipment to 

determine the size of respiration and converts it 

into a respiration waveform. Through this 

algorithm, it is determined whether or not to 

correct breathing[4-6]. Q.Static scan mode (GE 

Healthcare, Waukesha, WI) is a phase-based 

gating correction method that extracts a portion 

of PET data from a stable part of the respiratory 

cycle. Since a relatively stable breathing area is 
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obtained, Q. Static scan reduces respiratory 

motion artifact and creates a corrected image[7]. 

In this study, DDG and Q.Static scan modes 

according to condition changes using a phantom 

are applied and a comparative experiment is 

performed to confirm and evaluate the 

practicality effect. 

 

II. Materials and Methods 

1. PET/CT 

(1) Basic principle 

PET is an imaging method using unstable radioactive 

isotopes such as 18F, 11C, 13N, and 15O, because the 

number of neutrons is relatively small compared to 

the number of protons in the nucleus. These 

radioactive isotopes emit a positron when a proton is 

converted into a neutron in the nucleus. After flying a 

certain distance, the positrons emitted in this way 

meet electrons around the nucleus and annihilate, 

emitting two gamma rays with an energy of 511 keV. 

At this time, the two gamma rays are emitted in 

opposite directions of 180° within a very small error 

range according to the law of conservation of energy 

and momentum, and PET detects them 

simultaneously and records the direction and position 

of the emitted gamma rays[1].  

 (2) Radioactive isotopes used in PET/CT 

The most widely used radiotracer for PET imaging is 

18F-labeled 18F-fluorodeoxyglucose(FDG), a 

glucose analogue. It provides information on 

abnormal glucose metabolism and is used for 

diagnosis of various diseases including malignant 

tumors, epilepsy, and Alzheimer's disease.  

 

Table 1 shows radioactive isotopes that are typically 
used for PET[1].  

Table 1. Radioactive isotopes used in PET 

Nuclide. HL(Min) Max energy(MeV) 

11
C 20.4 0.96 

13
N 9.96 1.20 

15
O 2.03 1.74 

18
F 109.7 0.63 

68
Ge 68.3 1.90 

82
Rb 1.25 3.40 

124
I 6000 2.13 

2. Artifacts 

Artifacts that can be produced during PET/CT 

include metal artifacts, respiration artifacts, and 

truncation artifacts. Among them, in the case of 

breathing, which is one of the purposes of this paper, 

the difference in position of the liver, an abdominal 

organ, due to breathing can occur up to 5.5 cm, and 

even during normal breathing or artificially stopping 

breathing, the difference is 2.5 cm and 0.9 cm, 

respectively[8]. Accordingly, artifacts caused by 

respiration may be created, and lesions may be 

distorted or affect reading without being accurately 

expressed in the portion where the artifacts are 

created [Figure 1]. 

 

Figure 1. Artifact creation by breathing motion 
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3. Respiratory correction 

As a method of correcting respiration, the 

Pulmonary toolkit attaches a respiration correction 

tube to the abdomen and displays the contraction and 

relaxation of the tube according to respiration as a 

graph, or the Rpm Respiratory gating system displays 

the movement of the patient's respiration as a graph 

to target the patient's abdomen. . The equipment had 

a correction method using software CTAC shift and 

an artifact correction method[9-11]. In this study, 

artifacts caused by respiratory motion were corrected 

using MotionFree (Device-less data-driven gated, 

DDG), a respiratory synchronization system installed 

in the equipment, and Q.static scan mode without 

installing such an external device, and its we want to 

evaluate practicality. 

III. research methods 

1. Experiment equipment and materials 

(1) Phantom 

The phantom (National Electrical Manufacturers 

Association (NEMA) IEC Body Phantom) is in the 

form of six spheres, each having a volume of 10, 13, 

17, 22, 28, and 37 mm. [Figure 2] 

 

Figure 2. Phantom: NEMA IEC Body Phantom 

 

(2) Position and velocity module 

LXSH2BD-50S-M9N2 (SMC, Tokyo, Japan), one of 

the LX Series models, was used as an electric 

actuator to adjust the position and speed. The LC6C-

220AD (SMC, Tokyo, Japan) used as an electric 

actuator positioning driver has a built-in pulse 

control function. Position information can be set up 

to 28 points, point movement can be controlled by 

PLC, and it is compatible with electric actuators and 

2-phase stepping motors. A PLC (Programmable 

Logic Controller) is a program-embedded control and 

monitoring device that stores a program instructing 

the operation process sequence in the control device 

and processes and operates according to the program 
[12].  

 

Figure 3. Position and speed control module 

Figure 3 is the actual appearance of the module that 

controls the position and speed, and as an operating 

system for controlling it, it has the same functions as 

Figure 4 based on Windows CE 6.0. Details are as 

follows [12]. 
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Figure 4. Operation screens such as distance and 
number of trips, reset, start, etc. 

① MONITORING SCREEN: When touched, it 
converts to the MOVING calibration constant value 
input screen of the device. 

② NOW TEST TIME: Movement time up to now 

③ NOW POS’ (unit, mm): current position 

④ NOW COUNT (unit, times): Number of round 
trips so far 

⑤ ST POS’ (unit, mm): Starting position for round 
trip (050) 

⑥ END POS’ (unit, times): End position for round 
trip (0~50) 

⑦ SPEED (unit, times/min): Setting the number of 
round trips per minute (0~20) 

⑧ COUNTER (unit, times): Setting the number of 
round trips (0~20000 times) 

⑨ JOG MOVE : JOG can be moved in MANUAL 
mode 

⑩ ERROR CODE: Displays the corresponding code 
when an error occurs 

⑪ RESET: HOME END RESET, HOME POS’: 
Stopped JOG to POS’ 0mm 

bring back 

⑫ MANUAL: Manually move JOG, 

⑬ AUTO: Move JOG with set value 

⑭ START: MOVING starts. Available only in 
AUTO state 

⑮ STOP: Stop MOVING 

(3) Data Acquisition PET/CT 

Discovery MI Generation 2 (GE healthcare, 

Milwaukee, WI) was used as equipment, and basic 

information is as follows. [Figure 5, Table 2] 

 

Figure 5. Discovery MI Generation 2 (GE healthcare, 
Milwaukee, WI, USA) 

Table 2. PET/CT basic information 

PET CT 

Detecter type SiPM 
Max scan 

Field of view 
50 cm 

Crystal type LBS 
Max. number 

of row 
64 row 

Crystal 

dimensions 

3.95×5.3×25 

mm 

Max. number 

of slices per 

gantry rotaion  

128  

Axial FOV 20 cm Detector size 40 mm 

Overlap ratio 23 % 
Detector 

elements 
54272 

Effective Axial 

FOV 
15.4 cm 

Max kVp 

range 

140 

kVp 

  

Max mA 

range 
600 mA 
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2. Experiment method 

(1) Experiment preparation and image acquisition 

method 

18F-fluorodeoxyglucose (FDG) mixed with 37 MBq 

in 600 cc of physiological saline was dispensed to 

each sphere and fixed to an electric actuator. The 

PET condition was set to 1 minute and 30 seconds 

per bed to apply the same as when examining the 

patient, and the image was reconstructed by applying 

the same algorithm. In the case of DDG, when the 

test starts, the breathing cycle is automatically 

recognized by movement, and in Q.Static scan mode, 

the phase offset (the area where data will not be 

acquired) and the phase width (the area where data 

will be acquired) are specified. 30% and 50%, 

respectively, were applied to be the same as the 

setting applied to the patient. The threshold for 

determining whether or not to apply DDG was also 

applied in the same setting as for patients [Figure 6]. 

 

Figure 6. Classification of phase offset and phase 
width in the respiratory cycle 

 

1) Measurement of the phantom movement 
distance and movement speed 

The phantom movement distance was set to 0 cm, 1 

cm, 2 cm, and 3 cm in consideration of the patient's 

situation, and the number of breaths was fixed at 15. 

Using a motion detector (Vernier Motion Detector 2), 

a data acquisition device (Vernier LabPro®), and a 

personal computer (LABTOP PC), it was confirmed 

that the correct motion was performed under the set 

conditions. The motion detector (Vernier Motion 

Detector 2) has a function of emitting ultrasonic 

waves from a gold foil ultrasonic transducer and 

receiving a returning echo. The measurement range 

of the motion detector is from 15 cm to 6 m, the 

resolution is ±1 mm, the frequency is 50 kHz, and the 

shape of the ultrasonic wave is a cone beam that is 15 

to 20° from the central axis. The time for the 

ultrasonic waves generated from the ultrasonic 

transducer to move to the breath-simulating motion 

phantom and return to the ultrasonic transducer was 

measured and transmitted to a data acquisition device 

(Vernier LabPro®), and the data were stored in a 

personal computer to analyze the movement distance 

and movement speed. [12] 

2) Change the travel distance 

After fixing the inclination of the electric actuator 

with the phantom installed at 0°, setting the 

respiratory rate to 15 times, and adjusting the 

movement distance to 0 cm, 1 cm, 2 cm, and 3 cm, 

respectively, the experiment image and DDG without 

applying DDG were obtained. The images applied 

and tested were compared respectively. 

3) Change the slope 

After setting the moving distance of the electric 

actuator to 1 cm and setting the respiratory rate to 15 

as in the previous experiment, experiment without 

applying DDG by adjusting the inclination to 0°, 2.5°, 

5°, and 10° using an electronic goniometer. One 

image and DDG applied and tested images were 
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compared [Figure 7]. 

 

Figure 7. Phantom before and after gradient 
adjustment 

 

3. Evaluation method 

ImageJ was used for PET/CT image analysis. ImageJ 

(National Institutes of Health, USA) is a Java-based 

free program for displaying, analyzing, and 

processing 8-bit, 16-bit, and 32-bit images. In this 

paper, the image was analyzed using the area, pixel 

value, and line plot profile using the Windows 

platform, Windows 10 OS, and ImageJ 1.8.0. 

(1) Changes in SUVmax and SUVmean 

Standardized Uptake Values (SUV) is a semi-

quantitative index that analyzes the relationship 

between radioactive uptake in a specific area, such as 

a tumor, under the assumption that the radionuclide 

injected into the measurement target is evenly 

distributed over the entire volume of the 

measurement target. SUV can be expressed by the 

equation below. 

 

SUVmax means the maximum value of the standard 

intake coefficient, and SUVmean means the average 

value of the standard intake coefficient. SUVmax and 

SUVmean were measured by setting the entire sphere 

in the image as a region of interest (ROI) [Figure 8] 
[13].  

 

Figure 8. SUV measurement method 

(2) Changes in area and density of images 
according to changes in moving distance and 
inclination.  

The data acquisition procedure for comparing the 

area of an image is ImageJ run -> File > Open -> 

Image > Type > 8-bit -> Image > Adjust > Threshold 

-> Plugins – Examples > Image Inventor -> Analyze 

> Measure -> off It proceeds in the order of line 

analysis. In order to reduce the error according to the 

user, the threshold range was set using the Auto 

function provided by the ImageJ program.  

 
Figure 9. Example of concentration measurement 
method 
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Figure 10. Example of area measurement method 
 

(3) Comparison of full tooth width, half height 
width, and 1/10 tooth width according to the 
presence or absence of DDG application 
 

The procedure for acquiring data to compare the full 

width maximum (FWM), full width half maximum 

(FWHM), and full width tenth maximum (FWTM) of 

images is to run ImageJ -> File > Open - > Image > 

Type > 8-bit -> Plugins – Examples > Image Inventor 

-> Central Line Settings -> Analyze > Plot Profile -> 

Off line analysis.  For image analysis, full width, 

half width, and 1/10th width used for radiation 

energy resolution, pulse duration of signal processing, 

bandwidth of communication, and apparent size of 

astronomical objects in astronomy were applied.  

The transposition width represents the length of the 

X-axis at the maximum value of the Y-axis 8-bit 

image of the line plot profile curve. The half-width 

represents the length of the X-axis at the middle 

value (1/2) of the maximum value of the Y-axis 8-bit 

image of the line plot profile curve. The 1/10 value 

represents the length of the X-axis at 1/10 of the 

maximum value of the Y-axis 8-bit image of the line 

plot profile curve. 

 

Figure 11. Full Width Maximum, Full Width Half 
Maximum, Full Width Tenth Maximum 
 

IV. Experiment result 

1. Respiratory simulating movement 
phantom movement distance and movement 
speed measurement results 
 

When the movement distance of the respiratory 

simulating motion phantom was set to 1 cm, the 

range of movement distance was 0 to -10.2 mm with 

an error of 1.64%, and when the movement distance 

was set to 2 cm, the range of movement distance was 

0.4 to -19.9 mm, an error of 1.77%, and when the 

movement distance was set to 3 cm, the movement 

distance range was -0.4 to -29.8 mm and an error of 

2.08%.  

The reason why the moving distance range appears 

as a negative number in the experimental results is 

that the measured distance decreases when the 

distance between the phantom and the motion 

monitor is close. 

The motion monitor used for the measurement was 

judged to be an acceptable level considering the error 

caused by the sampling being set at 0.3 seconds due 

to the limitation of increasing the sampling speed as 

a device using ultrasonic waves. 
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Figure 12. Moving distance range according to the 
moving distance of the respiratory simulating motion 
phantom 
 

When the movement distance of the respiratory 

simulating motion phantom was set to 1 cm, the 

movement speed range was -32.47 to 32.93 cm/min, 

and when the movement distance was set to 2 cm, the 

movement speed range was -63.72 to 64.03 cm /min, 

and when the movement distance was set to 3 cm, the 

moving speed range was -91.77 to 92.08 cm/min. 

Assuming uniform motion at 15 times per minute and 

moving distances of 1 cm, 2 cm, and 3 cm, the 

moving speeds are 26.67 cm/min, 53.33 cm/min, and 

80.00 cm/min, respectively, but the respiratory 

simulation was a stop at the start and end points of 

the reciprocating motion, and the moving speed at 

the midpoint corresponded to the fastest region. In 

the moving distance graph and moving speed graph, 

it was confirmed that the trspiratory simulating 

motion phantom reflected the set conditions.  

 

 

 

 

 

2. SUVmax and SUVmean measurement 
results 

(1) Change of movement distance 

A. SUVmax 

 
In the DDG of SUVmax according to the moving 

distance, the X-axis moving distance was set to 0cm, 

1cm, 2cm, and 3cm, and the Y-axis SUVmax was the 

maximum value of the standard uptake coefficient. 

The diameters of the six spheres included in the 

phantom (National Electrical Manufacturers 

Association (NEMA) IEC Body Phantom) were 10 

mm, 13 mm, 17 mm, 22 mm, 28 mm, and 37 mm, 

respectively. In SUVmax, the larger the sphere 

diameter, the smaller the effect of the movement 

distance, and the smaller the sphere diameter, the 

larger the effect of the movement distance. The mean 

and standard deviation of SUVmax at the moving 

distances of 0 cm, 1 cm, 2 cm, and 3 cm were 

13.03±0.39, 11.95±1.81, 10.25±3.64, and 8.07±3.82 

in the DDG unapplied image, respectively. In the 

case of motion, the image DDG applied had a higher 

average SUVmax than the image DDG unapplied, 

and the standard deviation was smaller, indicating 

that there was a correction effect. 

A correction effect of SUVmax according to the 

moving distance. the X-axis is the diameter of the 

phantom sphere, which is 10 mm, 13 mm, 17 mm, 22 

mm, 28 mm, and 37 mm, respectively, and the 

SUVmax on the Y-axis is the maximum standard 

uptake coefficient. Based on the moving distance, it 

was found that the average SUVmax moving 

distance was improved in the image to which DDG 

was applied compared to the image to which DDG 

was not applied. Also, based on the diameter of the 

phantom sphere, it was found that the average 
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SUVmax of the DDG-applied image was improved 

compared to the DDG-unapplied image. 

 

B. SUVmean 

Figure 13. SUVmean (DDG applied and DDG 
unapplied) according to the moving distance 

Figure 13-a is the DDG application graph of 

SUVmean according to the moving distance, and 

Figure 13-b is the DDG unapplied graph. In DDG of 

SUVmean according to moving distance, the moving 

distance was set as 0cm, 1cm, 2cm, and 3cm on the 

X-axis, and SUVmean on the Y-axis is the average 

value of standard uptake coefficients. As for 

SUVmean, the larger the diameter of the sphere, the 

smaller the effect of the distance traveled, and the 

smaller the diameter of the sphere, the greater the 

effect of the distance traveled. As the moving 

distance increases, the SUVmean decreases 

regardless of the size of the sphere. The mean and 

standard deviation of SUVmean at the moving 

distances of 0 cm, 1 cm, 2 cm, and 3 cm were 

9.67±0.71, 8.87±0.90, 8.15±1.24, and 6.89±1.52, 

respectively, in the DDG-applied images . The 

images DDG unapplied were 9.63±0.68, 8.15±1.17, 

6.79±1.89, and 5.40±2.07, respectively. In the case of 

motion, the average of SUVmean was higher in the 

image to which DDG was applied than in the image 

to which DDG was not applied, and the standard 

deviation was small, indicating that there was a 

correction effect. 

 

 
Figure 14. SUVmean correction effect according to 
movement distance 
 

A SUVmean is correction effect according to 

movement distance. On the X-axis, the diameters of 

the phantom spheres were 10 mm, 13 mm, 17 mm, 

22 mm, 28 mm, and 37 mm, respectively, and the 

SUVmean on the Y-axis is the mean value of the 

standard uptake coefficient. Based on the moving 

distance, it was found that the average SUVmean 

moving distance of the DDG-applied image was 

improved compared to the DDG-unapplied image. 

Based on the diameter of the phantom sphere, it was 

found that the average SUVmean of the DDG-

applied image was improved compared to the DDG-

unapplied image. 
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(2) gradient change 

 
A. SUVmax 

 

 
Figure 15. SUVmax according to gradient(DDG 
applied and DDG unapplied images) 
 

Figure 15-a is a graph of SUVmax applied DDG 

according to the gradient, and Figure 15-b is a graph 

of unapplied DDG. In the figure, the X-axis is the 

gradient, 0°, 2.5°, 5°, and 10°, and the Y-axis is the 

maximum value of the standard uptake coefficient of 

SUVmax. The diameters of the six spheres in the 

phantom were 10 mm, 13 mm, 17 mm, 22 mm, 28 

mm, and 37 mm, respectively, as in the moving 

distance change experiment. It was found that as the 

gradient increases, SUVmax decreases regardless of 

the size of the sphere. 

The mean and standard deviation of SUVmax at 

gradients of 0°, 2.5°, 5°, and 10° were 12.87±1.35, 

12.04±1.90, 8.79±1.23, and 8.14±1.40 in the image 

to which DDG was applied, respectively, in the 

image of DDG unapplied, respectively which were 

9.94±0.63, 9.17±0.52, 7.18±0.79, and 6.70±0.89.In 

the case of motion, it was found that the standard 

deviation of the DDG-applied image was larger than 

that of the non-DDG-applied image. However, it was 

found that the average of SUVmax was higher and 

there was a correction effect. 

 

 
Figure 16. SUVmax correction effect according to 
the gradients 
 

Figure 16 is a graph of the correction effect of 

SUVmax according to the gradients. In the figure, the 

X-axis is the diameter of the phantom sphere, which 

is 10 mm, 13 mm, 17 mm, 22 mm, 28 mm, and 37 

mm, respectively, and the SUVmax on the Y-axis is 

the maximum standard uptake coefficient. It was 

found that the image to which DDG was applied 

improved the average SUVmax by 2.93, 2.87, 1.61, 

and 1.45 at inclinations of 0°, 2.5°, 5°, and 10°, 

respectively, compared to the image of DDG-

unapplied . It was found that the average SUVmax 

was improved in the image to which DDG was 

applied compared to the image to which DDG was 

not applied. 
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B. SUVmean 

 

 

Figure 17. SUVmean according to gradient(DDG 
applied and DDG unapplied images) 
 
Figure 17 “a” is the DDG applied graph of SUVmean 

according to the gradients, and Figure 17 “b” is the 

DDG unapplied graph. The X-axis is the gradient, 

and it was set at 0°, 2.5°, 5°, and 10°, and the 

SUVmean of the Y-axis is the average value of the 

standard uptake coefficient. The diameters of the six 

spheres in the phantom were 10 mm, 13 mm, 17 mm, 

22 mm, 28 mm, and 37 mm, respectively. As the 

gradient increased, the SUVmean decreased 

regardless of the sphere size. The mean and standard 

deviation of SUVmean at gradients of 0°, 2.5°, 5°, 

and 10° were 10.80±0.63, 9.87±1.37, 7.53±0.68, and 

7.13±0.68 in the DDG applied image, respectively. It 

was 9.19±0.54, 8.60±0.41, 6.72±0.49, and 6.18±0.60, 

respectively, in the image of DDG unapplied. In the 

case of motion, the standard deviation of the image 

applied DDG was higher than the image unapplied 

DDG, but the average of SUVmean was higher, 

indicating that there was a correction effect. 

 
Figure 18. SUVmean correction effect according to 
the gradients 
 

Figure 18 is a graph of the correction effect of 

SUVmean according to the gradients. The X-axis 

was the diameter of the phantom sphere, 10 mm, 13 

mm, 17 mm, 22 mm, 28 mm, and 37 mm, 

respectively. SUVmean on the Y-axis is the average 

value of standard uptake coefficients. When the 

gradient was the criterion, the image of applied DDG 

improved the average SUVmean by 1.61, 1.27, 0.80, 

and 0.95 at gradients of 0°, 2.5°, 5°, and 10°, 

respectively, compared to images of unapplied DDG. 

When the diameter of the phantom was the criterion, 

on the image of DDG applied has a SUVmean of 

0.56, 0.44, 1.19, 0.98, It was found to improve 1.66 

and 2.13. 
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3. Changes in the area and density of 
images according to the change in moving 
distance and gradient 
 

A. Change in moving distance 

1) Visual comparison 

 

In the visual comparison of the moving distance 

change images with and without DDG application, 

the hot cell boundary of the image changed 

indistinctly as the moving distance increased to 0 cm, 

1 cm, 2 cm, and 3 cm regardless of whether or not 

DDG was applied. In addition, when DDG was 

applied, it was qualitatively confirmed that there was 

a correction effect at all of the movement distances of 

1 cm, 2 cm, and 3 cm. It was found that the 

correction effect of DDG increased as the moving 

distance increased. 

2) Area ratio 

In the 37mm sphere, the ratio of hot cell area 

according to the movement distance increased by 7%, 

18%, and 30% at movement distances of 1cm, 2cm, 

and 3cm compared to the reference image 

(movement distance of 0 cm) when DDG was not 

applied. And, when DDG was applied, the movement 

distance compared to the reference image (movement 

distance 0 cm) increased by 2%, 6%, and 12% at 1cm, 

2cm, and 3cm, respectively. The difference between 

when DDG was applied and when it was not applied 

was 5%, 12%, and 18% at 1 cm, 2 cm, and 3 cm, 

respectively, which means the quantitative correction 

effect when DDG was applied, and the standard It 

was corrected toward closer to the ten-pixel area of 

the image. 

 

3) Average concentration ratio 

 
Figure 19. Ratio of hot cell average density by 
moving distance on a 37 mm sphere. 
 

In Figure 19, the X-axis is the movement distance, 0 

cm, 1 cm, 2 cm, 3 cm, and the Y-axis is the average 

density ratio, “a” is the average density of hot cells in 

the reference image, “b” is 0 cm, it means the 

average concentration at 1 cm, 2 cm, and 3 cm. The 

average density ratio of the comparison image 

compared to the reference image with a moving 

distance of 0 cm decreased by 3%, 8%, and 13% at 

moving distances of 1 cm, 2 cm, and 3 cm, 

respectively, when DDG was not applied, and when 

DDG was applied the moving distance decreased by 

0%, 3%, and 5% at 1 cm, 2 cm, and 3 cm, 

respectively. The difference between when DDG was 

applied and when it was not applied was 3%, 6%, 

and 8% at 1 cm, 2 cm, and 3 cm, respectively. This 

means the quantitative correction effect when using 

the DDG correction program, and it was corrected to 

be close to the average density of the reference image. 

B. Gradient change 

1) Visual comparison 

Table 3. Visual comparison of gradient change 
images with and without DDG application 
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As shown in Table 3, when the images of gradient 

changes with and without DDG application were 

visually compared, the borderline of the image 

changed indistinctly as the gradient increased to 0°, 

2.5°, 5°, and 10° in both methods. When DDG was 

applied, it was qualitatively confirmed that there was 

a correction effect at all moving distances of 2.5°, 5°, 

and 10°. The correction effect of applying DDG was 

found to be greater as the gradient increased. 

 
2) Area ratio 

 
Figure 20. Hot cell area ratio according to gradient 
on a 37 mm sphere 

The X-axis in Figure 20 is the gradient, 0°, 2.5°, 5°, 

10°, and the Y-axis is the area ratio. "a" means the 

area of hot cell of the reference image. "b" means the 

area of hot cell at 0°, 2.5°, 5°, and 10°. When DDG 

was not applied, the area ratio of the reference image 

with an inclination of 0° and the comparison image 

with an inclination of 2.5°, 5°, and 10° increased by 

7%, 8%, and 3%, respectively. And when DDG was 

applied, the gradient increased by 1% and 1% at 2.5° 

and 5°, respectively, and decreased by 4% at 10°. The 

difference between when DDG was applied and 

when it was not applied was 6%, 7%, and 7% at 2.5°, 

5°, and 10°, respectively. This means the quantitative 

correction effect when DDG is applied. It was 

corrected to the side close to the hot cell area of the 

reference image. However, at 10°, the correction was 

excessive, resulting in 4% smaller than the reference 

image. 

3) Average concentration ratio 

 
Figure 21. Hot cell average density ratio according to 
gradient on a 37 mm sphere 
 
The X-axis in Figure 21 is the gradient 0°, 2.5°, 5°, 

10°, and the Y-axis is the average density ratio. "a" 

means the average density of hot cell of the reference 

image, and "b" means the average density of hot cell 

at 0°, 2.5°, 5°, and 10°. When DDG was not applied, 

5%, 4%, and 7% decreased in the reference image 

with 0° grdient and the 2.5°, 5°, and 10° images, 

respectively. When DDG was applied, the gradient 

decreased by 2%, 1%, and 2% at 2.5°, 5°, and 10°, 

respectively. The difference between when DDG was 

applied and when it was not applied was 3%, 4%, 

and 5% at 2.5°, 5°, and 10°, respectively. This means 

the quantitative correction effect when DDG was 

applied, and it was corrected to be close to the 

average density of hot cell of the reference image. 
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4. Comparison of FWM, FWHM, and 
FWTM with and without DDG application 
 
A. Change in moving distance 
 

 
Figure 22. Profile curve according moving distance 
 
Figure 22 shows the density of the area for each 

moving distance using ImageJ, and was drawn based 

on the experimentally acquired images according to 

the moving distance. Figure 22 “a” is the density 

graph without applying DDG according to the 

moving distance, and 21 “b” is the density graph with 

the application of DDG according to the moving 

distance. Figure 22 “c” is a graph comparing an 

image with a moving distance of 3 cm to an image 

with a moving distance of 0 cm. Through this, it was 

confirmed that the images were widely distributed 

compared to the image when the moving distance 

was 0 cm, which is the reference image. 

1) Comparison of FWM ratio 

 
Figure 23. Comparison of FWM ratio change with 
and without DDG application 
 

In Figure 23, the X-axis represents the moving 

distance at 0 cm, 1 cm, 2 cm, and 3 cm, and the Y-

axis represents the FWM ratio. “a” means the FWM 

of the hot cell of the reference image, and “b” means 

the FWM of the hot cell at 0 cm, 1 cm, 2 cm, and 3 

cm. When DDG was not applied, as a result of 

comparing the reference image with a moving 

distance of 0 cm and the images at moving distances 

of 1 cm, 2 cm, and 3 cm, the reduction was reduced 

by 3.5%, 13.6%, and 18.7%, respectively. And when 

DDG was applied, the movement distance decreased 

by 2%, 4.6%, and 9.2% at 1 cm, 2 cm, and 3 cm, 

respectively. The difference between when DDG was 

applied and when it was not applied was 1.6%, 9%, 

and 9.4% at 1 cm, 2 cm, and 3 cm, respectively. This 

means the quantitative correction effect when DDG 

is applied, and it was corrected to the side close to 

the FWM of the hot cell of the reference image. The 

transposition width of all images decreased when 

DDG was applied and when it was not applied. This 

is because the hot cell of the moving image appear 

smaller than they actually are. 

 

2) Comparison of FWHM ratio 

 
Figure 24. Comparison of FWHM ratio change with 
and without DDG application 
 

The X-axis in Figure 24 is the moving distance, 0 cm, 

1 cm, 2 cm, and 3 cm, and the Y-axis is the FWHM 



16 SJMI(2022) 01; 1-20     

 

 

ratio. “a” means a FWHM of a hot cell of the 

reference image, and “b” means a FWHM of a hot 

cell in 0 cm, 1 cm, 2 cm, and 3 cm. When DDG was 

not applied, the FWHM ratio increased to 14.9%, 

22.6%, and 28.8% in the reference image with a 

moving distance of 0 cm and the comparison images 

with moving distances of 1 cm, 2 cm, and 3 cm. 

When DDG was applied, the moving distance 

increased by 10.5%, 14.9%, and 22.3% in 1 cm, 2 cm, 

and 3 cm, respectively. The difference between when 

DDG was applied and when it was not applied was 

4.4%, 7.6%, and 6.4% at 1 cm, 2 cm, and 3 cm, 

respectively. This means the quantitative correction 

effect when DDG is applied and means that it is 

corrected to the side close to the FWHM of the hot 

cells of the reference image. 

The FWHM of the image increased both when DDG 

was applied and when it was not applied. The reason 

is that the hot cells of the moving image are 

magnified more than they actually are. 

 

3) Comparison of FWTM ratio 

 

Figure 25. Comparison of FWTM ratio change with 
and without DDG application 
 

The X-axis in Figure 25 is the moving distance in 0 

cm, 1 cm, 2 cm, and 3 cm, and the Y-axis is the 

FWTM ratio. “a” means the hot cell FWTM of the 

reference image, and “b” means the FWTM of the 

hot cell at 0 cm, 1 cm, 2 cm, and 3 cm. When DDG 

was not applied, the FWTM ratio increased by 32.3%, 

54.8%, and 80.1% in the reference image with a 

moving distance of 0 cm and the comparative images 

with moving distances of 1 cm, 2 cm, and 3 cm, 

respectively . When DDG was applied, it increased 

by 20.1%, 31.4%, and 49.6% in images of 1 cm, 2 

cm, and 3 cm, respectively. The difference between 

when DDG was applied and when it was not applied 

was 12.1%, 23.4%, and 30.5% at 1 cm, 2 cm, and 3 

cm, respectively. This means the quantitative 

correction effect when DDG is applied and means 

that it is corrected to the side close to the FWTM of 

the hot cell of the reference image. The FWTM of 

the image increased both when DDG was applied and 

when it was not applied. The reason is that the hot 

cell of the moving image is enlarged more than the 

real one. 

B. Gradient change 

 
Figure 26. Profile curve according to gradient 
 
In Figure 26, "a" is the density graph according to the 

gradient when DDG is not applied, and "b" is the 

density graph when DDG is applied. "c" is a graph 

comparing a reference image with an gradient of 0° 

and a comparison image with an gradient of 10° 

when DDG is applied. In the "c" graph, it was found 

that when DDG was applied, it became closer to the 

reference image. 

1) Comparison of FWM ratio 
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Figure 27. Comparison of FWM of gradient change 
images with and without DDG application 
 

The X-axis in Figure 27 is the gradient 0°, 2.5°, 5°, 

10°, and the Y-axis is the FWM ratio. “a” means the 

hot cell FWM of the reference image, and “b” means 

the hot cell FWM at 0°, 2.5°, 5°, and 10°. When 

DDG was not applied, the FWM ratio decreased by 

7.0%, 6.0%, and 19.9% in the reference image with 

an gradient of 0° and the comparison image with an 

gradient of 2.5°, 5°, and 10°, respectively. When 

DDG was applied, the FWM ratio decreased by 4.1%, 

2.8%, and 8.2%, respectively, in the 2.5°, 5°, and 10° 

comparison images. The difference between applying 

and not applying DDG was 3.0%, 3.2%, and 11.7% 

at 2.5°, 5°, and 10°, respectively. This means the 

quantitative correction effect when DDG is applied 

and means that it is corrected closer to the hot cell 

FWM of the reference image. The FWM of the 

image decreased both when DDG was applied and 

when it was not applied. The reason is that the hot 

cell of the moving image are reduced than they 

actually are. 

2) Comparison of FWHM ratio 

 
Figure 28. Comparison of FWHM of gradient change 
images with and without DDG application 
 

The X-axis in Figure 28 is the inclination of 0°, 2.5°, 

5°, and 10°, and the Y-axis is the FWHM ratio. “a” 

means the hot cell FWHM of the reference image, 

and “b” means the hot cell FWHM at 0°, 2.5°, 5°, 

and 10°. When DDG was not applied, the FWHM 

ratio increased by 13.0%, 14.6%, and 10.5% in the 

reference image with an inclination of 0° and the 

comparison image with an inclination of 2.5°, 5°, and 

10°, respectively. When DDG was applied, it 

increased by 10.3, 9.6%, and 8.2%, respectively, in 

comparison images with slopes of 2.5°, 5°, and 10°. 

The difference between applying and not applying 

DDG was 2.7%, 5.0%, and 2.3% at 2.5°, 5°, and 10°, 

respectively. This means that the quantitative 

correction effect when DDG was applied and the 

correction was made to the side close to the hot cell 

FWHM of the reference image. The FWHM of the 

image decreased both when DDG was applied and 

when it was not applied. 

3) Comparison of FWTM ratio 
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Figure 29. Comparison of FWTM of gradient change 
images with and without DDG application 

The X-axis of Figure 29 is the inclination of 0°, 2.5°, 

5°, and 10°, and the Y-axis is the FWTM ratio. “a” 

means the hot cell FWTM of the reference image, 

and “b” means the hot cell FWTM at 0°, 2.5°, 5°, and 

10°. When DDG was not applied, it increased by 

33.2%, 31.1%, and 32.8% in the reference image 

with an inclination of 0° and the comparison image 

with an inclination of 2.5°, 5°, and 10°, respectively. 

When DDG was applied, in comparison images with 

slopes of 2.5°, 5°, and 10°, increased by 21.1%, 

24.9%, and 25.3%, respectively. The difference 

between applying and not applying DDG was 12.2%, 

6.3%, and 7.5% at 2.5°, 5°, and 10°, respectively. 

This means the quantitative correction effect when 

DDG is applied and means that it is corrected closer 

to the hot cell FWTM of the reference image. The 

FWTM of the image decreased both when DDG was 

applied and when it was not applied. The reason is 

that the hot cell of the moving image are magnified 

more than they actually are. 

V. Review 

The average correction effect according to the 

moving distance through the experiment was as 

follows.  

1. As for the correction effect of the moving distance 

criterion, SUVmax was improved by 1.92, 2.48, 3.23, 

and 3.00 when DDG was applied, and SUVmean was 

improved by 0.04, 0.72, 1.36, and 1.49, respectively. 

2. The correction effect based on the phantom sphere 

diameter improved SUVmax by 2.37, 2.02, 1.44, 

1.20, 0.42, 0.52, and SUVmean by 1.36, 1.23, 0.99, 

0.82, 0.57, and 0.43, respectively, when DDG was 

applied.  

The average correction effect according to the 

dradient was as follows.  

1. The correction effect based on the slope improved 

SUVmax by 2.93, 2.87, 1.61, 1.45, and SUVmean by 

1.61, 1.27, 0.80, and 0.95, respectively, when DDG 

was applied.  

2. The correction effect based on the phantom sphere 

diameter was 0.77, 1.73, 1.84, 2.56, and 3.46 

respectively for SUVmax when DDG was applied. 

2.93 and SUVmean improved by 0.56, 0.44, 1.19, 

0.98, 1.66, and 2.13, respectively.  

In the visual comparison according to the change in 

the moving distance and the gradient, the correction 

effect of DDG increased as the moving distance 

increased and the gradient increased. In the case of 

the area ratio, the difference between the reference 

image with the moving distance of 0 cm and DDG 

applied and not applied was 5%, 12%, and 18%, 

respectively. In the reference image with an gradient 

of 0° and the comparison image with an gradient of 

2.5°, 5°, and 10°, the difference between applying 

and not applying DDG was 6%, 7%, and 7%, 

respectively. It was confirmed that there was a 

correction effect.  

In the case of the average density ratio, the difference 

between applying and not applying DDG was 3%, 

6%, and 8%, respectively, in the reference image and 

comparison image with a moving distance of 0 cm. 

In the reference image and comparative image with a 

gradient of 0°, the average density ratio showed a 
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difference of 3%, 4%, and 5% with and without 

DDG application, respectively.  

When comparing FWM, FWHM, and FWTM, the 

difference between applying and not applying DDG 

according to the change in moving distance was 

1.6%, 9%, and 9.4% in FWM, 4.4%, 7.6%, and 6.4% 

in FWHM, and 12.1%, 23.4% and 30.5% in FWTM, 

respectively. In the gradient change, the difference 

between applying and not applying DDG was 3.0%, 

3.2%, and 11.7% in FWM, 2.7%, 5.0%, and 2.3% in 

FWHM, and 12.2%, 6.3%, and 7.5% in FWTM. 

 This means the quantitative correction effect when 

DDG is applied. As a result, it was found that there 

was a correction effect in the overall experiment 

according to the change of the moving distance and 

dradient when DDG was applied. However, this 

experiment result this is not a direct application to 

this the patient, but an experiment using a phantom, 

and even if a three-dimensional motion is created by 

combining with an electric actuator by tilting, it is 

different from the actual respiration movement of the 

patient. the error should be taken into account. In 

addition, since the waveform of the motion of the 

electric actuator may be different from the waveform 

of respiration, the resulting error should be 

considered. It has been reported that it is appropriate 

to apply the phase offset and phase width adjustment 

ranges of 30% to 50% in Q.Static scan mode, but this 

also varies depending on the degree of movement for 

each patient, so errors in range adjustment should 

also be considered[14].  

In addition, when DDG is applied by setting the 

range of phase width to 50% using Q.Static scan 

mode, it is pointed out as an inevitable disadvantage 

that the inspection time is doubled compared to the 

existing inspection time. 

VI. conclusion 

During PET/CT examination, artifacts due to 

respiration inevitably occur, and if a lesion is located 

in the lower lung or upper liver, the artifact due to 

respiration must be corrected for accurate 

measurement and examination of SUV or reading 

error. DDG and Q.static scan mode were used among 

methods to reduce artifacts caused by respiration, and 

the movement of respiration was simulated using a 

phantom. Through the results of the experiment 

according to the change of the moving distance and 

the gradient, it was found that when DDG was 

applied to artifacts caused by motion, there was a 

correction effect more than when DDG was not 

applied. 

In addition, because it does not require the 

installation of a separate external device to correct 

respiration, improved images can be obtained more 

simply. As a result, it is possible to reduce time 

consumption examination time delay due to the 

installation of an external device, and a reduction in 

radiation exposure of the operator can be expected. 

In this paper, a method to improve the quantitative 

PET image quality by applying DDG and Q.static 

scan mode was proposed. 
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